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Introduction 

This document collates instructions for various tasks involved in reviewing and producing 

training modules for a client. It was shared internally as a resource document. To serve as a 

work sample, it has been shortened and anonymised. 

Tools and Documents 

Tools 

• To work with audio, use Audacity (http://audacity.sourceforge.net/), a free piece of 

sound recording and editing software. 

• Consultants compose the slides and script in a Microsoft Word template. 

• Create slides in Microsoft PowerPoint. 

• To finalise the project, import the slides into Articulate Storyline and add the audio. 

Documents 

The resources for this project are held on SharePoint: 

• Consultant - Requirements and scripting template: The document templates 

consultants use to collect content for their modules. 

• All - PPT template: The presentation template uses to create presentations. Consultants 

may also use this when they work on the script. 

• All - Condensed style guide: Information from various client sources collected together 

in a PDF with the style information and wording relevant to this project. 

http://audacity.sourceforge.net/
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Working with Scripts 

Before sending the script for recording, have a look through it. Make it as easy as possible 

for the voice-over artist to do the recording so anything that we can do to make the text 

easy to read out loud is useful. 

• Remember to make sure that the same voice over artist does all the modules in a given 

track. (This is the ideal outcome – it might in fact not be possible.) 

• Read through the script and make sure that it makes sense. Reading it out under your 

breath helps. 

• For the final script, break up large paragraphs into shorter ones. That helps the voice 

over artist keep their place on the page: long paragraphs, like long sentences, are easy 

to get lost in when reading them out loud. 

• Pay attention to the formatting. To make it easy for the voice over artist, set the text to 

12pt and double-space it, ensure that each slide starts on its own page. 

• Look for things that don’t translate between written and spoken language and write 

them out: 

• Abbreviations: e.g. change to ‘for example’, i.e. change to ‘that is’, or, even better, 

re-write to remove. Other types of abbreviations should be spelled out at least the 

first time they appear unless they are in the public domain. 

 

So that the script is easy to read, check pronunciation of terms and write them out: 

S.D.H for SDH indicates that each letter is pronounced separately. SONET is 

pronounced sonnet and is best written that way in the script that is recorded. SMPTE 

is a standards body who pronounce their name ‘sempty’. It’s always best to check. 

YouTube is a great resource for pronunciation, as is the client website. 

• Numbers in lists: spell out in short list (especially if the list uses Roman numerals). 

• Complicated punctuation: parentheses work, but hyphens, forward slashes and 

brackets can be difficult to interpret. Simplify the structure. 

 

Some people write like they speak – peppering scripts with dashes and parentheses. 
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That’s great when they’re reading the script themselves but can be unclear to an 

outsider. Where possible, clarify. 

• Over-long sentences and paragraphs: try to keep text airy on the page to make it 

easier for the voice-over artist to keep track of their position. 

• New terms: is there something you’re not sure how it should be pronounced? Or a 

term that’s not in common usage? Check pronunciation and include advice to the 

voice-over artist in the email you send with the script. 
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Working with Slides 

Reviewing Slides 

Before starting work on the slides, read the script to get a feeling for what the module is 

about. Then look at any slides and slide suggestions that have been given. 

Things to look for when reviewing a slide deck are: 

• How long is it? If it’s significantly over 10 slides, and things can’t easily be stacked, ask 

the consultant to revise. We’re pretty flexible though: sometimes stacking slides on top 

of each other takes more time than reviewing a few extra individual slides. 

• Is the style correct? Check that bullet points (see section Recreating the client Bullet 

Points below), colours and styles are consistent with the client style: flat shapes, no 

shading. Occasional use of a pale grey gradient behind elements. 

• Does it have the default slides? Each deck should have: 

• A cover slide with the name of the track followed by the name of the training 

module. 

• An agenda slide. Animate it so that the agenda items fade in with the voice over. 

• An end slide with the text: You have completed <track>: <module>  

The module name should be on a new line. 

• Make sure there are not too many words on the slide. Many trainees will read what’s 

on the slide and tune out the voice. The majority of messages is in the voice over and 

highlights should be picked out on the slides. 

• Is what’s on the slides exactly what’s in the script? That’s not good. The slides should 

give highlights from the message in the script, not repeat it. There’s often an 

opportunity to remove words from the slide. 

• Are there slides that don’t make sense or need re-making? Let the consultant know and 

make suggestions/implement. 
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• Is there non-The client clip-art? Use a consistent look, replacing clip art and icons with 

clean, colour appropriate images where possible. (The resources we have can be found 

on SharePoint; we might have to make more as things come in.) 

• Are there logos for other companies on the slides? We shouldn’t use logos we don’t 

have the rights to so replace them with symbols of the type of company instead. Saying 

that, social media icons are acceptable. 

• Is the text legible? Text under 10.5 points will not be. Ideally, no text should be smaller 

than 12pt. body text is 18pt by standard (heading text 24, with sub-headings at 20). 

References (Source: this and that) can be 12pt and should be either left aligned or 

centered under the item they reference. 

• Re-use slides. If you recognize something from another deck, don’t be afraid to re-use. 

For example, the SE modules typically have slides on issues (call outs around a 

concerned looking gentleman), and buying agents that can be re-used or adapted from 

previous presentations. 

• Use animation. To liven the slide up when there’s a lot of voice over, fade important 

elements in and out. When reviewing the slides, there’s no need to worry about timing – 

we’ll look at that when producing the final document. The client’s default slide transition 

is a fade, which is why we use fades in and out for animation. 

• Does it have a slide number? It probably will. You don’t need it so remove it. 

Recreating Client Bullet Points 

The client uses their own bullet points: red arrows. They are not standard in PowerPoint and 

they are tricky to recreate exactly. It’s not always possible to replace non-compliant bullet 

points with the client’s own: if copying a text field with bullet points from the corporate 

template, or from another slide, doesn’t give you the style you need, you can fake it. This is 

how: 

1. Highlight the text you want to add bullet points to. 

2. Click the bullet point options and select Bullets and Numbering. 

3. Click Customize. 
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4. From Font, select Wingdings and then find character 224, an arrow with a short shaft 

and a wide head. (It’s one page down, bottom row, six columns in.) 

5. Click OK. 

6. Back in the bullets and Numbering dialog, select the client red for the colour and set 

the size to 75% of the text. 

7. Click OK. 

Importing Audio into PowerPoint 

Note: this step is not necessary for the client project because the software we’ll use to 

create the output files strips the audio from the presentation. Instead, we add the audio 

directly into Articulate Storyline. 

To import the audio file into PowerPoint: 

1. Launch PowerPoint. 

2. Open the presentation. 

3. Click the Transitions tab. 

4. In the Timing group, scroll down in the Sound list to Other Sound. 

5. Browse to the sound files for the relevant course. 

6. Select a sound file and click OK. 
The sound is played immediately so you can hear that it has been added. 
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Working with Audio in Audacity 

Recording Audio 

To record the audio, we’re using Audacity.  

1. Launch Audacity. 

2. Record one file for each slide in the script. 

3. Save the audio as a WAV file, and name it according to the course and slide number (for 

example, COURSE1_1). 

Removing Noise from Audio 

Unless we have access to a sound-proof booth, any audio we record is likely to pick up 

ambient sound like traffic, or the general background hum of computers and heating 

systems. We can remove this to make the audio track smoother. 

To remove noise from audio in Audacity: 

1. Open a file: 

a. Click File and then Open. 

b. Navigate to the file. 

The first few seconds of the audio should be silence.  

2. Use the cursor to select one or two seconds of silence. 

3. Click Effects and then Noise Removal. 

The Noise Removal dialog is displayed. You'll notice that there are two steps to the 

process: creating a noise profile, and then using that profile to remove noise from the 

entire file. 

4. Click Get Noise Profile. 

The process might take a second. 

5. Deselect the silence. 
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6. Return to the Noise Profile dialog (click Effects followed by Noise Removal). 

7. Use the default settings and click OK. 

The file is scrubbed of ambient sound.  

Amplifying Audio 

If the recording is quiet, it is possible to amplify it in audacity. Do this after removing noise 

so that you’re amplifying as clean a source as possible. 

To amplify a voice over in Audacity: 

1. Open a file. 

2. Click Effects and then Amplify. 

The Amplify dialog automatically shows you the max the file can be amplified to. If 

possible, amplify to 11.5. If the displayed max is less, go with the suggestion. 

3. Click Preview to ensure that the audio doesn’t sound overly tinny or odd after 

amplification. 

4. Click OK. 

You’ll notice that the audio is amplified since the waveform is now larger. 

Removing Silence in Audacity 

It is also possible to use Audacity to cut over-long intros and outros, or removing overlong 

silences. (This can also be done in Storyline, see Removing Silence in Storyline, page 14, but 

Audacity’s zoom feature offers better accuracy.) 

To remove silence: 

1. Open an audio file (select File, then Open and browse to the file you want to edit). 

2. With the cursor, select the area you want to remove. 

If it is difficult to see exactly where a small sound starts, either  

a. use the zoom tool (a magnifying glass) to zoom, or  

b. press CTRL and zoom with the mouse wheel. 
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3. Click the Cut button (a pair of scissors). 

4. When editing is complete, select Export Audio from the File menu. 

5. Save the edited file with a new name. 
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Creating Training Modules 

When the recorded audio comes in, it is time to create and finalise the training module. At 

the end of this process, the module is delivered. 

The process for creating a training module is: 

1. Create a new project and import slides (described in Creating a New Project in Articulate 

Storyline, page 11). 

2. Set up the project (described in Setting up a Project, on page 12). 

3. Add audio (described in Importing Audio to a Presentation, page 14). 

4. Fine-tune each slide (described in Fine-tuning a Module, page 15). 

Creating a New Project in Articulate Storyline 

Each of the training modules will have its own module in Articulate Storyline.  

To create a new project: 

1. Open Articulate Storyline. 

2. Click Import and then Import PowerPoint. 

3. Browse to the presentation you want to import. 

4. Double-click the file to start the import. 

You are shown a list of the slides in the presentation, in case you want to only import a 

few. By default, they are all selected. 

5. Select to import to the current scene. 

6. Click Import. 

The slides are imported. This can take a little while, depending on how complex they 

are. 

7. Save the project with the same name as the training module (in full or abbreviated form, 

whatever is quickest and most clear). 

You are now ready to set up and fine-tune the presentation, and add audio and quizzes. 
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Setting up a Project 

As well as adding audio, there are a few steps that have to be taken each time a new project 

is created. 

• Set slide progression. 

• Adjust the footer in Master view. 

• Set up the Player look and feel. 

• Check the LMS settings. 

Setting up Slide Progression 

Learners have to click Next to progress from one scene to another. By default, storyline sets 

slide progression to automatic, so it is possible to start the module and let it run until it 

finishes. 

To set slide progression: 

1. Select the Story View. 

2. Select all slides in the view. 

3. Under Slide Properties, set Slide Advance to By user. 

Now when you click a specific slide, it should show two triggers, one for jump to next, 

and one for jump to previous, both when the user clicks a button. No slides should have 

a trigger that progresses at, for example, the end of the timeline. 

Adjusting the Footer 

When Storyline imports the client template, it doesn’t deal with the footer correctly. Instead 

of showing it all on one line it wraps it so that it ends with ‘Confidential &’. To fix this: 

1. In Storyline, go to the View tab. 

2. Click Slide Master. 

Find the client master. 

3. On the top-level master, extend the Copyright text box so that the text fits on one line. 

4. Repeat this action on the cover and end slide masters. 
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5. Click Close Master View to return to the Story View. 

Note: Sometimes, the page number is left in the template. Remove this too as the menu 

makes it unnecessary. 

Setting up the Player 

The Player is how the learner interacts with the VOD. We can make a number of different 

settings here that affects how the VOD looks. 

To set up the Player in Storyline: 

1. Click Player. 

This opens the Player Properties window. 

2. Under Player Tabs, deselect Resources. 

3. Under Features, enter the track and the module title into the Title field, for example 

Sales Expert: Smart Utility Networking. 

4. Under Controls, select Seekbar. 

5. Click Menu. 

The table or content, or menu, structure is displayed. 

6. Check that the slide names are accurate: the top topic probably has the same name as 

the PowerPoint file. Change it to the name of the course, for example: Sales Expert: 

Smart Utility Networking. 

a. Change the name of the first topic to Agenda. 

b. Remove the last topic, the one made by the closing slide, so that Summary is the 

last topic. 

7. Click the Settings icon. 

The Menu Options dialog is displayed. 

8. Select Wrap long menu item titles. 

9. Check that Number entries… is deselected. 

10. Click OK to close the Menu options dialog. 

11. Click OK to close the Player Properties window. 
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Checking LMS Settings 

1. Click Publish 

The Publish window is displayed. 

2. Click LMS and them Reporting and Tracking. 

3. Click Tracking. 

4. Check that Track using number of slides viewed is selected. 

5. Click OK to close the Reporting and Tracking options dialog. 

6. Still on the LMS tab, deselect Use Storyline Player and its sub-option. (If this isn’t done, 

the output won’t work with the client’s LMS.) 

7. If you are ready to publish, continue to Publishing a Module, on page 17. 

Importing Audio to a Presentation 

Each slide, not counting the quiz slides, come with a voice-over. The voice over should start 

about a second after the slide has been displayed, and the slide should remain on the screen 

for a second after the voice-over has finished. 

In an Articulate Storyline project: 

1. Double-click the first slide to open it, if you’re not already in slide view. 

2. Click the Insert tab and select Audio, then Audio from File. 

3. Browse to the file you want to add. 

4. Double-click it to add it. 

5. If you need to, remove overly long pauses, intros and outros. 

6. Adjust the start point so that the speech (as opposed to the track itself) starts just after 

the first second. 

Tip: Place the Playhead at 1 second when importing audio to align the track with where 

it should start automatically. 

7. Adjust the slide’s end point to about a second after the audio has finished. 
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Removing Silence in Storyline 

Once the audio has been added, remove extraneous silence at the beginning and end of the 

file.  

To remove silence from audio by removing the section: 

1. In Storyline, double-click the audio track. An editing window opens. 

2. Select the area you want to remove. 

3. Press Delete. 

4. Close the window (by clicking the Close icon in the top right-hand corner). 

5. Click Yes to save the changes. 

To remove silence from audio by removing adding silence: 

1. In Storyline, double-click the audio track. An editing window opens. 

2. Select the area you want to silence. 

3. Click Silence. 

The selected area is turned into silence. 

4. Close the window (by clicking the Close icon in the top right-hand corner). 

5. Click Yes to save the changes. 

Fine-tuning a Module 

Exactly how you work with the presentation is up to you, but here’s a suggested process. 

For each slide: 

1. Make a note of the main animation points on the slide. 

2. Listen to the audio and make a note of the times where elements should come in. 

3. On the timeline, add cues where animations should come in. 

4. Align elements to cues. 

Tip: Groups don't align easily. Expand and align the elements, or ungroup and align. 

If you've ungrouped, you'll have to re-apply animation. 
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5. Preview the slide. 

Tip: there are two ways to preview, the quick and dirty way is clicking the Play button on 

the timeline. This plays the scene in the timeline from the playhead position. The other 

way is to go to Preview and select This Slide. This plays the scene in a player. The first is 

great for checking logic during slide development; the latter for final checks. 

6. Make any adjustments. 

7. When finished, preview the entire project and make notes of anything that needs to be 

fixed. 

Things to think about when previewing the module: 

• Is there content on the slides that could be cued up to the voice over?  

Having all the content on the slide all the time means that students are likely to read the 

text and tune out the voice. 

• Does graphics and audio work? 

Sometimes what looks sensible in a presentation, when you’re reading the script in your 

head, doesn’t work so well with in reality. 

• Is there a lot of talk with little action on screen? 

Sometimes, what works with the PowerPoint presentation doesn’t work with a VOD. For 

example, some of the scripts have long voiceovers where only the end is cued up to 

what’s on the presentation. When this is the case, you might have to add something to 

the beginning of the slide: if it’s blank for more than ten seconds or so, it looks as if 

something’s not right with the slide. 

• Are items still aligned? 

Storyline sometimes move elements during import so that things that were aligned in 

the presentation file go out of alignment ever so slightly. This can affect text placement 

in diagrams, for example. 

• Is text still legible? 

To be legible, text shouldn’t be below 10pts in size. Ideally, it should be larger. Storyline 

shrinks text on import, so headings and other text often needs to be enlarged. 
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• Are diagrams big enough? 

Sometimes, a diagram that looks OK size-wise on a slide can still look a little small in a 

VOD. If that’s the case, re-size it to make it bigger. 

Publishing a Module 

When you’ve added the audio, fine-tuned the presentation and finalized the script, it’s time 

to publish the module and send it for internal review. 

To publish the module: 

1. In the project, click Publish. 

2. Enter the track and module title. 

3. Add a short description (use the brief summary from the cover slide). 

4. Output it to a local folder.  

Publishing it to the same folder as the project means it’s easy to find. 

5. Leave other the defaults as they are. 

6. Click Publish. 

7. When given the option to view etc, select ZIP. (Output zipped outside of Storyline won’t 

work with the client’s LMS.) 

Reviewing a Module 

Before we send the module to the consultant, it needs to be reviewed internally.  

1. ZIP up the output file. 

2. Add it to the module’s SharePoint folder. 

3. Ask someone in the DTP team to review it. 

To view the module: 

1. Download the ZIP to a local drive. 

2. Unpack it. 

3. Open the resulting folder. 
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4. Double-click story.html to launch the module in a web browser. 

Remember to allow all content and turn off pop-up blockers or the content might not 

display. 

What are we looking for? Anything that’s not quite right. Spelling mistakes, alignment that’s 

off, timings that don’t quite work, or anything else that looks odd. 

After implementing any feedback from the internal review, publish the external version of 

the module and share that on SharePoint. Inform the consultant that it is ready for external 

review. 

Finalising a Module 

Once the module is finalized  

• upload the output to the Published Box folder, and  

• compress the project file and upload it to OneDrive. 
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